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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications,
enhancements, improvements, and other changes to its products and services at any time and to discontinue
any product or service without notice. Customers should obtain the latest relevant information before placing
orders and should verify that such information is current and complete. All products are sold subject to TI’s terms
and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in
accordance with TI’s standard warranty. Testing and other quality control techniques are used to the extent TI
deems necessary to support this warranty. Except where mandated by government requirements, testing of all
parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for
their products and applications using TI components. To minimize the risks associated with customer products
and applications, customers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right,
copyright, mask work right, or other TI intellectual property right relating to any combination, machine, or process
in which TI products or services are used. Information published by TI regarding third–party products or services
does not constitute a license from TI to use such products or services or a warranty or endorsement thereof.
Use of such information may require a license from a third party under the patents or other intellectual property
of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of information in TI data books or data sheets is permissible only if reproduction is without
alteration and is accompanied by all associated warranties, conditions, limitations, and notices. Reproduction
of this information with alteration is an unfair and deceptive business practice. TI is not responsible or liable for
such altered documentation.

Resale of TI products or services with statements different from or beyond the parameters  stated by TI for that
product or service voids all express and any implied warranties for the associated TI product or service and
is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Mailing Address:

Texas Instruments
Post Office Box 655303
Dallas, Texas 75265

Copyright   2001, Texas Instruments Incorporated



EVM IMPORTANT NOTICE

Texas Instruments (TI) provides the enclosed product(s) under the following conditions:

This evaluation kit being sold by TI is intended for use for ENGINEERING
DEVELOPMENT OR EVALUATION PURPOSES ONLY and is not considered by TI to
be fit for commercial use. As such, the goods being provided may not be complete in terms
of required design-, marketing-, and/or manufacturing-related protective considerations,
including product safety measures typically found in the end product incorporating the
goods. As a prototype, this product does not fall within the scope of the European Union
directive on electromagnetic compatibility and therefore may not meet the technical
requirements of the directive.

Should this evaluation kit not meet the specifications indicated in the EVM User’s Guide,
the kit may be returned within 30 days from the date of delivery for a full refund. THE
FOREGOING WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY SELLER TO
BUYER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR
STATUTORY, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE.

The user assumes all responsibility and liability for proper and safe handling of the goods.
Further, the user indemnifies TI from all claims arising from the handling or use of the
goods. Please be aware that the products received may not be regulatory compliant or
agency certified  (FCC, UL, CE, etc.). Due to the open construction of the product, it is
the user’s responsibility to take any and all appropriate precautions with regard to
electrostatic discharge.

EXCEPT TO THE EXTENT OF THE INDEMNITY SET FORTH ABOVE, NEITHER
PARTY SHALL BE LIABLE TO THE OTHER FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

TI currently deals with a variety of customers for products, and therefore our arrangement
with the user is not exclusive.

TI assumes no liability for applications assistance, customer product design,
software performance, or infringement of patents or services described herein.

Please read the EVM User’s Guide and, specifically, the EVM Warnings and Restrictions
notice in the EVM User’s Guide prior to handling the product. This notice contains
important safety information about temperatures and voltages. For further safety
concerns, please contact the TI application engineer.

Persons handling the product must have electronics training and observe good laboratory
practice standards.

No license is granted under any patent right or other intellectual property right of TI
covering or relating to any machine, process, or combination in which such TI products
or services might be or are used.
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EVM WARNINGS AND RESTRICTIONS

It is important to operate this EVM within the input voltage range of 1 V and the output voltage
range of 0 V and 5 V.

Exceeding the specified input range may cause unexpected operation and/or irreversible
damage to the EVM. If there are questions concerning the input range, please contact a TI
field representative prior to connecting the input power.

Applying loads outside of the specified output range may result in unintended operation and/or
possible permanent damage to the EVM. Please consult the EVM User’s Guide prior to
connecting any load to the EVM output. If there is uncertainty as to the load specification,
please contact a TI field representative.

During normal operation, some circuit components may have case temperatures greater than
70°C. The EVM is designed to operate properly with certain components above 70°C as long
as the input and output ranges are maintained. These components include but are not limited
to linear regulators, switching transistors, pass transistors, and current sense resistors. These
types of devices can be identified using the EVM schematic located in the EVM User’s Guide.
When placing measurement probes near these devices during operation, please be aware
that these devices may be very warm to the touch.
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Preface

Read This First

About This Manual

How to Use This Manual

This document contains the following chapters:

� Chapter 1—Functional Description

� Chapter 2—Setup and Configuration

� Chapter 3—System Operation

� Chapter 4—Troubleshooting the TVP5031/5040/5145EVM

� Appendix 1—TVP5031/5040/5145EVM Schematics and Board Layouts

Notational Conventions

This document uses the following conventions.

� Program listings, program examples, and interactive displays are shown
in a special typeface similar to a typewriter’s. Examples use a bold
version of the special typeface for emphasis; interactive displays use a
bold version of the special typeface to distinguish commands that you
enter from items that the system displays (such as prompts, command
output, error messages, etc.).

Here is a sample program listing:

0011  0005  0001         .field    1, 2
0012  0005  0003         .field    3, 4
0013  0005  0006         .field    6, 3
0014  0006               .even

Here is an example of a system prompt and a command that you might
enter:

C: csr –a /user/ti/simuboard/utilities
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� In syntax descriptions, the instruction, command, or directive is in a bold
typeface font and parameters are in an italic typeface. Portions of a syntax
that are in bold should be entered as shown; portions of a syntax that are
in italics describe the type of information that should be entered. Here is
an example of a directive syntax:

.asect ”section name”, address

.asect is the directive. This directive has two parameters, indicated by sec-
tion name and address. When you use .asect, the first parameter must be
an actual section name, enclosed in double quotes; the second parameter
must be an address.

� Square brackets ( [ and ] ) identify an optional parameter. If you use an
optional parameter, you specify the information within the brackets; you
don’t enter the brackets themselves. Here’s an example of an instruction
that has an optional parameter:

LALK 16–bit constant [, shift]

The LALK instruction has two parameters. The first parameter, 16-bit con-
stant, is required. The second parameter, shift, is optional. As this syntax
shows, if you use the optional second parameter, you must precede it with
a comma.

Square brackets are also used as part of the pathname specification for
VMS pathnames; in this case, the brackets are actually part of the path-
name (they are not optional).

� Braces ( { and } ) indicate a list. The symbol | (read as or) separates items
within the list. Here’s an example of a list:

{ * | *+ | *– }

This provides three choices: *, *+, or *–.

Unless the list is enclosed in square brackets, you must choose one item
from the list.

� Some directives can have a varying number of parameters. For example,
the .byte directive can have up to 100 parameters. The syntax for this di-
rective is:

.byte value1 [, ... , valuen]

This syntax shows that .byte must have at least one value parameter, but
you have the option of supplying additional value parameters, separated
by commas.

FCC Warning

This equipment is intended for use in a laboratory test environment only. It
generates, uses, and can radiate radio frequency energy and has not been
tested for compliance with the limits of computing devices pursuant to subpart
J of part 15 of FCC rules, which are designed to provide reasonable protection
against radio frequency interference. Operation of this equipment in other
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environments may cause interference with radio communications, in which
case the user at his own expense will be required to take whatever measures
may be required to correct this interference.

Trademarks

Windows is a trademark of Microsoft.
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Functional Description

The TVP5031/5040/5145EVM evaluation module is a stand-alone printed
circuit board designed for demonstration of the TVP5031, TVP5040, or the
TVP5145 video decoder with the TVP6000 NTSC/PAL video encoder. The
board is designed to provide ease of use while allowing full evaluation of the
TVP5xxx video decoder.

Topic Page

1.1 Description Overview 1-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Chapter 1



Description Overview

1-2

1.1 Description Overview

The TVP5031/5040/5145EVM uses the PC parallel port to emulate the I2C
bus, which provides communication with the TVP5xxx video decoder and the
video encoder. The WinVCC4 application software that communicates with
the devices via I2C has been provided.

The analog video inputs supported by the TVP5031/5040/5145EVM include
composite video, S-video, and component video. The video inputs available
depend on the TVP5xxx video decoder under evaluation. This is discussed in
more detail in the Video Input Description section. In general, the video
decoder converts the analog video input signal into digital YUV data. This
digital YUV data and the associated clocks from the video decoder are sent
to the video encoder. The video encoder then converts the digital YUV data
back into an analog video output signal. The analog video outputs supported
by the video encoder include composite video and S-video.

When evaluating the performance of the TVP5xxx video decoder, the
preferred method is to take the video decoder output directly to a studio-quality
video encoder. The digital YUV data is output in ITU–R BT.656 format through
the connector labeled Digital Component Video Out.

To experiment with the programmable features of the TVP5xxx video decoder
and the video encoder, the parallel port of the TVP5031/5040/5145EVM is
connected to the parallel port of a PC. A Windows  compatible application
provides the user interface for performing register-level and high-level control
of the TVP5xxx video decoder and the video encoder. This application is called
WinVCC4 (Windows Video Chipset Control Program).

1.1.1 Board-Level Description

The board-level block diagram of the TVP5031/5040/5145EVM is shown in
Figure 1–1. The primary features are listed below.

� TVP5xxx video decoder
� TVP6000 NTSC/PAL video encoder
� Parallel port interface for I2C emulation
� ITU–R BT.656 digital component video output
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Figure 1–1. TVP5031/5040/5145EVMEVM Board-Level Block Diagram
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† Component video input is only supported by the TVP5145.
‡ S-video input is not supported by the TVP5031.

1.1.2 Video Input Description

The following explains the various video input configurations available
depending on the specific TVP5xxx video decoder.

Table 1–1.TVP5031/5040/5145EVM Video Input Configurations

EVM Type
Composite

Input(s)
S-Video

Input
Component

Input Video Input Label(s) on EVM

TVP5031EVM 1 NA NA Composite/Y–IN

TVP5040EVM 2 1 NA Composite/Y–IN, Pr–IN, S–IN

TVP5145EVM 3 1 1 Composite/Y–IN, Pr–IN, Pb–IN, S–IN

Note:

The Composite 1 video input source is selected by default in the WinVCC4
application program. This can be changed by going to Edit → Property
Sheets → TVP5xxx, and clicking on the Analog tab. The video input source
is selected here.

1.1.2.1 TVP5031EVM

The TVP5031 video decoder supports two composite inputs. It does not
support S-video input or component video input. Only the first composite video
input is available on the TVP5031EVM. This composite video input is labeled
Composite/Y–IN on the board.
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1.1.2.2 TVP5040EVM

The TVP5040 video decoder supports up to four composite inputs or two
S-video inputs. It does not support component video input. The TVP5040EVM
supports two composite inputs and one S-video input. The first composite
video input is labeled Composite/Y–IN. The second composite input is labeled
Pr–IN on the board. The S-video input is labeled S–IN.

1.1.2.3 TVP5145EVM

The TVP5145 video decoder supports up to two component inputs, six
composite inputs, two S-video inputs or one digital video input. The
TVP5145EVM however only supports three composite inputs, one S-video
input, and one component input. The first composite video input is labeled
Composite/Y-IN. The second composite input is labeled Pr-IN on the board.
The third is labeled Pb-IN. The S-video input is labeled S-IN. The component
input is labeled Composite/Y-IN, Pr-IN, Pb-IN.

1.1.3 Video Output Description

Composite and S-video outputs are supported on all TVP5031/5040/
5145EVMs.

1.1.4 System-Level Description

A system-level block diagram incorporating the TVP5031/5040/5145EVM is
shown in Figure 1–2. Typical, commercially available test equipment is also
shown. The primary features of this configuration are listed below.

� Power is provided by individual supply sources: –5V, +5V, GND

� Supported analog inputs include composite video, S-video or component
video

� Re-encoded composite video or S-video output via onboard video
encoder

� Optional ITU–R BT.656 digital component video output for external
re-encoding

� I2C bus initialization of the video devices

� TVP5xxx video decoder performance parameters may be measured with
a video analyzer.

� TVP5xxx video decoder performance can be viewed and compared with
the source video.
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Figure 1–2. TVP5031/5040/5145EVM System Level Block Diagram
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Setup and Configuration

The following summarizes the steps for setup and operation of this EVM.
Please follow the steps in the order shown.

1) Software Installation or Updating the Software

2) Hardware Configuration

Topic Page
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2.1 Software Installation

All necessary software for the TVP5031/5040/5145EVM is provided on
enclosed CD-ROM. Both the EVM software and the device files must be
installed on the PC emulating the I2C bus via the parallel port.

1) Insert the CD-ROM into the computer that will emulate the I2C bus via the
parallel port

2) Run the Port95NT.exe file first to install the parallel port driver.

3) Run SETUP.EXE file to install WinVCC4.

4) Click Next at all prompts and finally click Finish to complete the installation
process.

2.1.1 Updating the Software

Visit www.ti.com or contact videohelponline@list.ti.com to obtain the latest
version of the EVM software and the device software.

2.2 Hardware Configuration

Figure 2–1 shows the TVP5031/5040/5145EVM layout and indicates the
location of the power supplies and the appropriate connectors. All connectors
are labeled according to their function. To prepare the EVM for evaluation,
connect the following:

� Power supplies: –5V, +5V and GND
� Parallel port cable to a PC
� Analog video in
� Analog video out
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Figure 2–1. TVP5031/5040/5145EVM Layout
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2.2.1 Using the ITU-R BT.656 Digital Video Output

To re-encode the TVP5xxx digital component video output, connect a ribbon
cable from TVP5031/5040/5145EVM connector labeled Digital Component
Video Out to the external encoder. This connector outputs the data in ITU–R
BT.656 format.
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Table 2–1.Digital Component Video Output Connector Pinout

Pin Name Pin Name

1 SCLKP 14 SCLKN

2 DGND 15 DGND

3 Y_P9 16 Y_N9

4 Y_P8 17 Y_N8

5 Y_P7 18 Y_N7

6 Y_P6 19 Y_N6

7 Y_P5 20 Y_N5

8 Y_P4 21 Y_N4

9 Y_P3 22 Y_N3

10 Y_P2 23 Y_N2

11 Y_P1 24 Y_N1

12 Y_P0 25 Y_N0

13 DGND
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System Operation

This chapter describes how to start and use the WinVCC4 application
program.
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3.1 Power Up

After Software Installation and Hardware Configuration have been completed,
the TVP5031/5040/5145EVM may be powered up.

3.2 Starting the WinVCC4 Application Program

The WinVCC4 application program must have been previously installed on the
PC. Run WinVCC4 from the Windows� Start Menu:

Start → Programs  TVP5031/5040/5145EVM Software → WinVCC4

3.2.1 Device I2C Address Configuration

The I2C Address Configuration window as shown in Figure 3–1 is now visible.
The TVP5145 video decoder and the TVP6000 video encoder are selected by
default. Select the specific video decoder from the drop-down list and click OK.
The I2C addresses for each are set according to the default setup on the
TVP5031/5040/5145EVM board.

Figure 3–1. I2C Address Configuration



Starting the WinVCC4 Application Program

3-3System Operation

Pressing OK will set the I2C device address for the TVP5xxx video decoder as
0xB8 and the video encoder as 0x40. The WinVCC4 software is now set up
to communicate with the video devices via I2C.

3.2.2 I2C Test Results

After the I2C Address Configuration window is closed, WinVCC4 performs a
test of all active devices on the I2C bus. A series of values are written and read
back from each device. The original values are then restored. If this test fails,
a dialog box similar to Figure 3–2 appears.

Figure 3–2. I2C Test Report

The most common causes of this problem are not having the EVM powered
on or not having the EVM connected to a PC parallel port. If these are not the
cause, this may indicate a problem with the EVM itself.
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3.2.3 The Main Menu

Once the I2C addresses have been configured for the TVP5xxx and the
TVP6000, the Main Menu is displayed as shown in Figure 3–3. This menu
provides a means of communication with each device. It also provides access
to the system initialization.

The system initialization allows both the TVP5xxx video decoder and video
encoder to be setup with predefined settings that are commonly used in video
applications.

Figure 3–3. Main Menu
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3.2.4 System Initialization

From the Main Menu, Tools–>System Initialization will display the window
shown in Figure 3–4. This provides the means for initializing the system using
a CMD file; a text file generated using any common editor. This is especially
useful for testing and comparing various changes in the device setup. A default
CMD file has been provided on the CD-ROM. This CMD file should contain
most of the desired setups.

Figure 3–4. System Initialization

The CMD file type is used to initialize the TVP5xxx video decoder and the video
encoder. The CMD file is a text file as seen in Figure 3–5 that contains up to
64 data sets, also referred to as setups. Each data set specifies a device file
to download and the register settings for that particular video mode. The
register settings may be listed in the CMD file itself and/or may be stored in a
separate INC file and be included in the CMD file using the include statement.

3.2.4.1 Example Command File

An example of one data set within a CMD file is shown below. There may be
up to 64 data sets within one CMD file. Each command file may have
independent register settings, a group of register settings within an include file,
or both.
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Figure 3–5. Example CMD File With One Data Set

BEGIN_DATASET              // Dataset 1

DATASET_NAME,”TVP5xxx v1.08 & TVP6000 Multi–Standard (ITU–R BT.601)”

WR_MEM,VID_DEC,TVP5040_AUTO.C

INCLUDE,5_P.INC             // Initialize TVP5xxx registers
WR_REG,VID_DEC,0x01,0x0D,0x47      // Set to ITU–R BT.601 sampling rate

RESET,VID_ENC,100            // Activate TVP6000 reset for 100ms
INCLUDE,6N6_P.INC            // Initialize TVP6000 registers

END_DATASET

///////////////////////////////////////////////

BEGIN_DATASET              // Dataset 2

DATASET_NAME,”Initialize my other I2C devices using a literal sub–address”

WR_REG,0x70,0x01,0x02,0x03  // Load my device at I2C device address 0x70
WR_REG,0x70,0x01,0x04,0x05

WR_REG,0x94,0x01,0x06,0x07  // Load my device at I2C device address 0x94
WR_REG,0x94,0x01,0x08,0x09

END_DATASET

///////////////////////////////////////////////
// NOTES:
// 1. No restriction on multiple nesting of INCLUDE statements.
// 2. Can include an entire command file (between END_DATASET and BEGIN_DATASET).

The CMD file is opened using the Browse button. Once the CMD file is opened,
the text list box displays the data set descriptions contained within the CMD
file. Click once on the desired data set description to select it. Click the
Program Device(s) Using Selected Dataset button to initialize the devices. The
devices are initialized when the progress status indicates Ready.

Note:

If Ready does not display, then the devices are not initialized and the I2C bus
is not communicating. See Troubleshooting the TVP5031/5040/5145EVM
for a solution.

Click the OK button to close the dialog box. On program exit, the initialization
file pathname and the data set selection number are saved in the Windows
registry to retain these settings for the next time WinVCC4 runs.

3.2.5 Saving Current Register Settings

Saving custom register settings is done by appending them to an existing
command file. To do this, open the System Initialization under Tools on the
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Main Menu, and click the button labeled Append Current Device Settings to
CMD File. A prompt will ask for a description of the setup. By default, a list of
current descriptions is provided. An item from the list may be selected and
modified. Clicking OK will add the description to the end of the data set
descriptions list.

To save to a new CMD file, click Browse and type a new file name.

3.2.6 Auto-Switch Capability

The auto-switch capability allows the video encoder to detect a change in the
video format. The change in format is detected by the WinVCC4 application
program, which continuously polls the video decoder. Once a change in video
format is detected, the registers within the video encoder are updated to
support the new format.

In order to work properly, the video encoder and decoder must be configured
on the I2C bus. The Multi-Standard dataset listed under System Initialization
must be loaded. This loads the auto-switch code. The auto-switch capability
is now enabled.

To monitor the I2C bus for communication issues the auto-switch capability
must be disabled since it continuously polls the video decoder via the I2C bus.
Once the auto-switch capability has been disabled, the I2C bus may be
monitored. The auto-switch capability may be disabled by going to Tools →
Video Standard Status Polling.

3.3 Using the WinVCC4 Application Program

The following sections describe how to use the WinVCC4 application program.

3.3.1 Main Menu

The menus, which are used to operate WinVCC4, are File, Edit, Tools, and
Help. The File menu’s only function is Exit, which terminates the program.
Table 3–1 is a summary of the main menu contents.

Table 3–1.Main Menu Summary

Menu Contents

File Exit WinVCC4

Edit Register Map Editors for selected devices

Property Sheets for selected devices

Tools System Initialization
Video Standard Status Polling

Multi-byte I2C Transfers for selected devices

Set I2C Delays

Help Display program version

3.3.2 Register Editing

The next sections describe the two available modes of register editing:
Register Map Editors and Property Sheets. Each of these functions can be
selected from the Edit menu on the Main Menu.
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3.3.2.1 Register Map Editor

The Register Map Editor as shown in Figure 3–6 allows the display and editing
of the entire register set of the device with a simple scrolling text box. Data is
displayed and entered in decimal or hexadecimal bytes by toggling the Hex
and Dec radio buttons.

Figure 3–6. Register Map Editor

Clicking the Read All button will read all registers within the device and display
the address and data in the text box. To read only one register, highlight the
address inside the text box and click Read. The data of the highlighted register
address is now updated. Notice the highlighted address and data values are
also displayed in the two small edit boxes.

To write to one register, again highlight the desired register address. When the
address and data values are displayed in the two small edit boxes, the address
or data value may be changed simply by clicking inside the edit box and
changing the value. Clicking the Write button will update the register address
in the small address text box with the value in the small data text box.

The functions of the buttons within the Register Map Editor are explained in
Table 3–2.

Table 3–2.Register Map Editor Button Controls

Button Control Definition

Read Reads the register address in the Address text box and updates the display.

Read All Reads all readable registers from the device indicated and updates display.

Hex Converts all register address and data in the list to hexadecimal

Dec Converts all register address and data in the list to decimal

Cancel Closes the dialog.

OK Writes all write-able registers, that have been changed in the dialog box, to hardware.

Closes the dialog.
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3.3.2.2 Generic I2C Register Map Editor

Using the WinVCC4 application program, it is possible to access any device
on the I2C bus. Figure 3–7 shows the Register Map Editor for Generic I2C
Access. This is used to modify the data of any accessible register within a
device on the I2C bus. The full address range of 0x00 to 0xFF is supported.
The I2C device address (for write mode) must be typed into the I2C Device
Address box

Figure 3–7. Register Map Editor for Generic I2C Access

3.3.2.3 Example: Disable the YUV Outputs

Click once on 03 in the address column, change the data text box to 09 and
click Write as shown in Figure 3–8.

Figure 3–8. Example: Disable the YUV Outputs
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3.3.2.4 Property Sheets

A property sheet for the TVP5xxx video decoder and the video encoder is
available on the Main Menu under Edit as shown in Figure 3–9. The property
sheet presents the register data in a user-friendly format. The data is
organized by function, with each function having its own page. The pages are
selected using the tabs at the top of the window.

Figure 3–9. Property Sheets

When the property sheet function starts, or when a different page is selected,
all readable registers in the device are read from hardware to initialize the
dialog pages. Values on the page are changed by manipulating the various
dialog controls as described in Table 3–3.
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Table 3–3.Use of Dialog Controls

Dialog Control What Do I Do With It? When is Hardware Updated?

Read-Only Edit Box Read status information N/A

Check Box Toggle a single bit After Apply Changes

Drop-Down List Select from a text list After Apply Changes

Edit Control Type a number After Apply Changes

Pushbutton Initiate an action Immediately

Spin-Edit Control Use up/down arrows or
type a number

Immediately

Slider Slide a lever Immediately

There are three buttons at the bottom of each page of the Property Sheet.
These are explained in Table 3–4.

Table 3–4.Property Sheet Button Controls

Button Control Definition

OK Writes all write-able registers, that have been changed to hardware.

Closes the dialog.

Cancel Causes all changes made to the dialog since the last Apply to be discarded. Changes
made to dialog controls with immediate hardware update are not discarded, since they
have already been changed in hardware.

Does not write to hardware.

Closes the dialog.

Apply Causes all changes made to the dialog since the last Apply to be written to hardware.

3.3.2.5 Example: Selecting the Video Input

The video decoder Analog page allows the selection of the active video input.
A drop-down box labeled Video Input as shown in Figure 3–10 is provided for
this purpose. The available entries in the drop-down box depend on which
video decoder is currently installed. To change it, select the desired video input
and click Apply.
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Figure 3–10. Example: Selecting the Video Input

3.3.3 Tool Descriptions

This section describes the tools available within the WinVCC4 application
program. The tools include:

� System Initialization
� Video Standard Status Polling
� Multibyte I2C Transfer
� Set I2C Delays

3.3.3.1 System Initialization Tool

System initialization is used to load a command file, select one of its data sets
and program the device(s).

3.3.3.2 VIdeo Standard Status Polling Tool

Video standard status polling, when checked, causes the video standard
status from the video decoder to be constantly polled. The polling begins once
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the video decoder is initialized. Unchecking this feature stops the polling
immediately. When the software detects a change in video standard or
sampling rate, the video encoder is immediately reprogrammed with the
correct register values.

3.3.3.3 Multibyte I2C Transfer Tool

Multibyte I2C Transfers defines how these transfers are performed for each
device. When checked, the PC will write and read multiple bytes to
consecutive addresses using a single I2C transfer (between I2C Start and I2C
Stop). The default setting is checked for the TVP6000 video encoder. When
unchecked, the PC will write and read using an I2C transfer for each byte. The
default setting is unchecked for the TI video decoders.

3.3.3.4 Set I2C Delay Tool

Set I2C Delays is a debug feature that does not require changing.
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Troubleshooting the TVP5031/5040/5145EVM

If you are experiencing problems with the TVP5031/5040/5145EVM hardware
or the WinVCC4 software, see Table 4–1 for available solutions.

Table 4–1.Troubleshooting Guide

Item Problem Cause Solution

1 After closing the initial I2C System
Configuration dialog box, the I2C Test
Result dialog box displays errors.

I2C communication
failed with the indicated
device(s)

Click OK to close the I2C Test Result
dialog box.
Follow the on screen instructions

2 The following message is displayed:
Is a parallel cable connected from the
computer’s LPT1 port to the evaluation
module (EVM), and power applied to the
EVM?

I2C communication
failed

Click Yes or No

3 NO was entered in item 2 and the
following message appeared: Connect a
parallel cable from the computer’s LPT1
port to the EVM and apply power to the
EVM. Then, click OK.

I2C communication
failed

Insure that PC parallel cable is connected
and EVM power is ON.
Click OK.
Program should continue normally by
displaying the main menu.

4 YES was entered in item 2, and the
following message appeared:
This program will not work with the
current parallel port configuration.
Restart the computer and run the BIOS
setup program. Set parallel port LPT1 to
ECP mode, if available, or to
bidirectional mode (sometimes called
PS/2 or BYTE mode). After clicking OK,
WinVCC4 terminates.

A noncompatible PC
parallel port
configuration was
detected.

Restart the computer and run the BIOS
setup program. Set parallel port LPT1 to
ECP mode, if available, or to bidirectional
mode.

5 WinVCC4 locks up Auto-switch polling on
I2C bus interrupted by
EVM power-down.

Close the WinVCC4 application program,
power–on EVM and restart WinVCC4.

6 While attempting to observe traffic on the
I2C bus, constant traffic is seen.

Auto-switch I2C polling
is in operation.

Disable by unchecking the Tools → Video
Standard Status Polling menu item.

7 TVP5xxx or TVP6000 does not initialize
using the System Initialization tool

Wrong initialization files Verify that the names of the device
software files (*.C) match the name of your
video decoder device.

8 The Video Input does not seem to work The devices were not
initialized correctly
The video input source
was not changed in the
Video Decoder Property
Sheet

Go to Edit → Property Sheets → TVP5xxx,
and click on the Analog tab. Verify and
change if necessary the selected Video
Input source. Composite 1 is selected by
default.

Chapter 4
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Table 4–1.  Troubleshooting Guide (Continued)

Item Problem Cause Solution

9 The Digital Component Video Output
does not seem to work

Power has not been
properly supplied to the
EVM

Verify all connections including the power
supplies

Verify that both +5 V and –5 V has been
properly supplied to the EVM

10 The MC10H124 devices located next to
the Digital Component Video Output get
hot

These devices are TTL
to ECL translators. It is
normal for them to get
hot.

NA
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Schematics and Board Layouts

This section contains schematics and board layouts.
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A.1 TVP5031/5040/5145EVM Schematics and Board Layouts
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